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Foreword  
Thank you for purchasing VT-SBC-RK66 single board computer (“the Board” or “the Product”). 
This manual intends to provide guidance and assistance necessary on setting up, operating or 
maintaining the Product. Please read this manual and make sure you understand the 
functionality of the Product before putting it into use. 

Intended Users 

This manual is intended for: 

• Embedded software developer 
• Custom development software engineer  
• Other technically qualified personnel 

Copyright 

Vantron Technology, Inc. (“Vantron”) reserves all rights of this manual, including the right to 
change the content, form, product features, and specifications contained herein at any time 
without prior notice. An up-to-date version of this manual is available at www.vantrontech.com.  

The trademarks in this manual, registered or not, are properties of their respective owners. 
Under no circumstances shall any part of this user manual be copied, reproduced, translated, 
or sold. This manual is not intended to be altered or used for other purposes unless otherwise 
permitted in writing by Vantron. Vantron reserves the right of all publicly released copies of 
this manual. 

Disclaimer 

While all information contained herein has been carefully checked to assure its accuracy in 
technical details and typography, Vantron does not assume any responsibility resulting from 
any error or features of this manual, nor from improper uses of this manual or the software.  

It is our practice to change part numbers when published ratings or features are changed, or 
when significant construction changes are made. However, some specifications of the Product 
may be changed without notice. 
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Technical Support and Assistance 

Should you have any question about the Product that is not covered in this manual, contact 
your sales representative for solution. Please include the following information in your 
question: 

• Product name and PO number; 
• Complete description of the problem; 
• Error message you received, if any. 

 

Vantron Technology, Inc.  

Address: 48434 Milmont Drive, Fremont, CA 94538 
Tel: (650) 422-3128   
Email: sales@vantrontech.com  
 

Symbology  

This manual uses the following signs to prompt users to pay special attention to relevant 
information. 

 Caution for latent damage to system or harm to personnel  

 Attention to important information or regulations 
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General Safety Instructions  

The Product is supposed be installed by knowledgeable, skilled persons familiar with local 
and/or international electrical codes and regulations. For your safety and prevention of 
damage to the Product, please read and observe carefully the following safety instructions 
prior to installation and operation. Keep this manual well for future reference.  

• Do not disassemble or otherwise modify the Product. Such action may cause heat 
generation, ignition, electronic shock, or other damages including human injury, and may 
void your warranty.  

• Keep the Product away from heat source, such as heater, heat dissipater, or engine casing. 

• Do not insert foreign materials into any opening of the Product as it may cause the Product 
to malfunction or burn out.   

• To ensure proper functioning and prevent overheating of the Product, do not cover or 
block the ventilation holes of the Product. 

• Follow the installation instructions with the installation tools provided or recommended. 

• The use or placement of the operation tools shall comply with the code of practice of such 
tools to avoid short circuit of the Product. 

• Cut off the power before inspection of the Product to avoid human injury or product 
damage. 
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Precautions for Power Cables and Accessories 

Use proper power source only. Make sure the supply voltage falls within the specified 
range.  

Place the cables properly at places without extrusion hazards. 

There is a coin cell battery for powering the RTC. Therefore, please avoid short circuit of 
the battery during transportation or operation at high temperatures. 

Cleaning instructions:  

• Power off before cleaning the Product 
• Do not use spray detergent 
• Clean with a damp cloth 
• Do not try to clean exposed electronic components unless with a dust collector 

Power off and contact Vantron technical support engineer in case of the following faults: 

• The Product is damaged 
• The temperature is excessively high 
• Fault is still not solved after troubleshooting according to this manual 

Do not use in combustible and explosive environment: 

• Keep away from combustible and explosive environment 
• Keep away from all energized circuits 
• Unauthorized removal of the enclosure from the device is not allowed 
• Do not change components unless the power cable is unplugged 
• In some cases, the device may still have residual voltage even if the power cable is 

unplugged. Therefore, it is a must to remove and fully discharge the device before 
replacement of the components. 
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 CHAPTER 1 INTRODUCTION 
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1.1 Product Overview 

VT-SBC-RK66 multi-functional single board computer is running the latest Android 11 
operating system. The high-performance board is GMS certified to enable customers to 
have unimpeded access to Google mobile services.  

The board is powered by RK3566, a cost-effective multi-core processor developed by 
Rockchip. With 4GB memory and 32GB eMMC storage, it features quick access to data and 
ultra large capacity. As such, it is capable of dealing with huge volume of data in a timely 
manner. 

With plenty of peripheral interfaces, a wide choice of peripherals can be connected for 
extended applications, including barcode scanners, cameras, barcode printers and 
keyboard plates. The SBC also supports ultra-high-definition video outputs as it offers a 
high-performance video engine coupled with HEVC hardware decoding and 1080p/2K video 
resolution. Moreover, display interfaces of different specifications allow flexible application 
of the device in intelligent retailing, new retailing, financial self-service terminals, and other 
scenarios. 

1.2 Terminology/Acronym 

Terminology/Acronym Description 
NC No connection 

VCC Voltage common collector 
GND Ground 
P (+) Positive of difference signal 
N (-) Negative of difference signal 

# Active low signal 
I Input 
O Output 

I/O Input/output 
P Power or ground 
A Analog 

OD Open drain 
PCIe PCI express signal 
MDI Media dependent interface 
BKL Backlight control 
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1.3 Specifications 

VT-SBC-RK66  

System 

CPU Rockchip RK3566, Quad-core ARM Cortex-A55, 1.8GHz (Max.) 
Memory 4GB 

Storage 32GB (up to 128GB) 
1 x Micro-SD (up to 128GB) 

Communication 
Ethernet 1 x RJ45, 10M/100M/1000Mbps 
Wi-Fi & Bluetooth Wi-Fi 802.11 a/b/g/n/ac + BT 5.0 
4G/LTE Supported (expansion by mini PCIe) 

Media 

Display 

1 x HDMI, Type-A, up to 4K × 2K @60Hz 
1 x 4-lane eDP, 2K @60Hz 
1 x 8-lane MIPI DSI connector (including 4 lanes multiplexed 

to LVDS): single-channel MIPI DSI: 1080P@60Hz, LVDS: 
720P @60Hz; dual-channel MIPI DSI: 2K @60Hz 

Audio 1 x 3.5mm combo audio jack 
Speaker 1 x Speaker connector 
Camera 1 x MIPI CSI, 2 x 10 x 2.0mm 

I/Os 

Serial port 
1 x RS232, DB9  
1 x RS232, pin header 
2 x RS232/RS485, DB9  

USB 4 x USB 2.0 Type-A (USB OTG supported) 
1 x USB 3.0 

SIM slot 1 x SIM card slot 
GPIO 8 x GPIO, 3.3V 
RTC Supported 
Watchdog Supported 

Expansion Mini-PCIe 1 x Mini-PCIe for 4G/LTE module 

System Control 

Button 1 x Reset button 

LED 

1 x 4G LED 
1 x Power LED  
1 x User defined 
1 x System LED 

Software 
OS Android 11, GMS certified (Optional: Linux OS) 
Device management 
platform Vantron BlueSphere MDM 

Power Input 12V/24V 3A DC (±5%), 1 x 3 x 3.81mm 
Mechanical Dimensions 155 x 105 x 16.4mm  

Environment 
Condition 

Temperature Operating: 0℃~+60℃ 
Storage: -40℃~+85℃ 

Humidity Operating: RH 5%~95% 
Storage: RH 5%~95% 

Certification FCC 
ESD: ±4KV (Contact) and ±8KV (Air) 
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1.4 Operating System 

VT-SBC-RK66 supports Android 11 operating systems, users also have the option of Linux 
operating systems. 

1.5 Mechanical Dimensions 
• 155 x 105 x 16.4mm 

 

 

 

 

 

 

 

 

 

1.6 Power Supply and Consumption 

VT-SBC-RK66 works with 12V/24V DC power input, supplied by a DC terminal block.  

Theoretically, the Board typically consumes about 15W of power. It should be pointed out 
that power consumption is largely determined by the RAM, storage capacity, and other 
configurations of the Board. 

1.7 Environmental Specifications 

VT-SBC-RK66 works at a temperature ranging from 0℃ to +60℃ and at relative humidity 
of 5%-95% for non-condensing purpose. 
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2.1 Product Layout 

 

 

 

 

 

 

 

 

 

 

 

 

The board I/Os will be described in detail in 2.4 Connectors and Jumpers following the 
sequencing numbers provided here. 

2.2 Memory 

VT-SBC-RK66 is equipped with a 4GB RAM.  

2.3 Identification of Pin 1  

Unless otherwise stated, pin 1 of a connector is seated on a square pad that is different 
from the round pads used for other pins. Sometimes, pin 1 is next to a trigonal mark on 
the board. When there are two rows of pins on a connector, the row with pin 1 is 
composed of odd numbers and the other is composed of even numbers. 

  

Usually, there will be numbers or marks next to the pins of a connector on the board to 
indicate the pinouts. 

 

(12) 
RS232/485 

(12) 
RS232/485 (11) RS232 

(17) RST 

(5) BKL 1  

(10) SPK 

(4) eDP 

(15) GPIO 

(1) Power in (19) 
Micro SD 

slot (13) 4 x 
 USB 2.0 (14)  

USB 3.0 

(9) Audio  
(3) HDMI 

(2) ETH 

(7) BKL 2  

(6) MIPI DSI/ 
LVDS 

(8) MIPI CSI 

(19) SIM slot  
at back 

(11) RS232 

(18) 4 x LED 
indicator  

RTC 

(16) Mini-PCIe 

OTG 
switch 
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2.4 Connectors and Jumpers 

This section is going to brief the connectors/jumpers on the Board with corresponsive 
pinout description. 

2.4.1 Power terminal (1) 

VT-SBC-RK66 implements a terminal block (1 × 3, 3.81mm, 10A) which is designed to 
connect to a 12V/24V DC (12V 3A recommended) power supply with over-voltage 
protection and over-current protection. Since the terminal block also provides backlight 
power supply, please take the input voltage of the backlight into consideration when 
selecting the power supply.  

 
 
 
 

Pinout description: 

Pin Name Type Description 

1 GND P Ground 
2 -VDC P 12V DC Power_In - 

3 +VDC P 12V DC Power_In + 

2.4.2 Ethernet jack (2) 

VT-SBC-3588 implements an RJ45 Ethernet jack with two LED indicators, green for activity 
indication and yellow for link indication. The port supports 10/100/1000 Mbps 
transmission rate.  

2.4.3 HDMI (3) 

There is an HDMI port (Type-A) on the Board, supporting HDMI 2.0a protocol with a 
resolution up to 4K × 2K @60Hz. 

  

1 

http://www.vantrontech.com/


Vantron | Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 VT-SBC-RK66 | User Manual                                            12 www.vantrontech.com 
 

2.4.4 eDP (4) 

VT-SBC-RK66 implements a 4-lane eDP connector (2 × 10 × 2.0mm) to connect an external 
screen via an extension cable.  

 

 

eDP pinout description: 

Pin Name Description 

1 EDP_TX_D0N eDP differential lane 0 negative 

2 EDP_TX_D1N eDP differential lane 1 negative 

3 EDP_TX_D0P eDP differential lane 0 positive 

4 EDP_TX_D1P eDP differential lane 1 positive 

5 GND Digital ground 

6 GND Digital ground 

7 EDP_TX_D2N eDP differential lane 2 negative 

8 EDP_TX_D3N eDP differential lane 3 negative 

9 EDP_TX_D2P eDP differential lane 2 positive 

10 EDP_TX_D3P eDP differential lane 3 positive 

11 GND Digital ground 

12 GND Digital ground 

13 EDP_TX_AUXN eDP differential AUX channel negative 

14 eDP_HPD Hot Plug Detect 

15 EDP_TX_AUXP eDP differential AUX channel positive 

16 GND Digital ground 

17 GND Digital ground 

18 GND Digital ground 

19 EDP_VDD Power Supply 

20 EDP_VDD Power Supply 

 

  

2 
1  
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2.4.5 Backlight connector 1 (5) 

There is an LCD backlight power connector BKL1 (1 x 6 x 2.0mm) that is designed to connect 
a backlight to increase readability of the LCD connected to the eDP connector in low light 
conditions.  

 

 

 

 

BKL1 pinout description: 

Pin Name Description 

1 EDP_BLK LCD power supply for LED driver 

2 EDP_BLK LCD power supply for LED driver 

3 EDP_BKLT_EN LED driver enabling 

4 EDP_BKLT_PWM PWM signal for LED driver 

5 GND Ground 

6 GND Ground 

2.4.6 MIPI DSI/LVDS (6) 

VT-SBC-RK66 implements a dual-channel 8-lane MIPI DSI connector (2 × 16 × 2.0mm) to 
connect an external screen via an extension cable. The connector has 4 lanes multiplexed 
to LVDS.  

 

 

MIPI DSI/LVDS pinout description:  

Pin Name Description 

1 MIPI1_DSI_DN3 MIPI1_DSI Differential Lane 3 - 

2 MIPI1_DSI_DP3 MIPI1_DSI Differential Lane 3 + 

3 MIPI1_DSI_CLKN MIPI1_DSI Differential Clock Lane - 

4 MIPI1_DSI_CLKP MIPI1_DSI Differential Clock Lane + 

5 GND Digital Ground 

6 GND Digital Ground 

7 MIPI1_DSI_DN2 MIPI1_DSI Differential Lane 2 - 

8 MIPI1_DSI_DP2 MIPI1_DSI Differential Lane 2 + 

1 

1 
2 
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9 MIPI1_DSI_DN1 MIPI1_DSI Differential Lane 1 - 

10 MIPI1_DSI_DP1 MIPI1_DSI Differential Lane 1 + 

11 MIPI1_DSI_DN0 MIPI1_DSI Differential Lane 0 - 

12 MIPI1_DSI_DP0 MIPI1_DSI Differential Lane0 + 

13 LVDS_MIPI0_DN3 LVDS/MIPI_DSI Differential Lane 3 - 

14 LVDS_MIPI0_DP3 LVDS/MIPI_DSI Differential Lane 3 + 

15 LVDS_MIPI0_CLKN LVDS/MIPI_DSI Differential Clock Lane - 

16 LVDS_MIPI0_CLKP LVDS/MIPI_DSI Differential Clock Lane + 

17 GND Digital Ground 

18 GND Digital Ground 

19 LVDS_MIPI0_DN2 LVDS/MIPI_DSI Differential Lane 2 - 

20 LVDS_MIPI0_DP2 LVDS/MIPI_DSI Differential Lane 2 + 

21 LVDS_MIPI0_DN1 LVDS/MIPI_DSI Differential Lane 1 - 

22 LVDS_MIPI0_DP1 LVDS/MIPI_DSI Differential Lane 1 + 

23 LVDS_MIPI0_DN0 LVDS/MIPI_DSI Differential Lane 0 - 

24 LVDS_MIPI0_DP0 LVDS/MIPI_DSI Differential Lane 0 + 

25 GND Digital Ground 

26 GND Digital Ground 

27 LVDS_PWR Power Supply 

28 GND Digital Ground 

29 LVDS_PWR Power Supply  

30 LVDS_PWR Power Supply 

31 GND Digital Ground 

32 GND Digital Ground 
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2.4.7 Backlight connector 2 (7) 

There is another LCD backlight power connector BKL2 (1 x 6 x 2.0mm) on the Board 
designed to connect a backlight to increase readability of the LCD connected to the MIPI 
DSI/LVDS connector in low light conditions.  

 

 

 

 

BKL2 pinout description: 

Pin Name Description 

1 LCD_BLK LCD Power Supply for LED Driver 

2 LCD_BLK LCD Power Supply for LED Driver 

3 LCD_BKLT_EN LED Driver Enabling 

4 LCD_BKLT_PWM PWM Signal for LED Driver 

5 GND Ground 

6 GND Ground 

2.4.8 MIPI CSI (8) 

VT-SBC-RK66 implements a MIPI CSI connector (2 × 10 × 2.0mm) for connecting HD 
cameras via an extension cable. 

 

 

 

Please refer to the next page for the pinout description of the connector. 

 

 

  

1 

2 
1  
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Pinout description: 

Pin Name Description 

1 MIPI_CSI_RX_D2N MIPI-CSI differential lane 2 negative 

2 MIPI_CSI_RX_D3N MIPI-CSI differential lane 3 negative 

3 MIPI_CSI_RX_D2P MIPI-CSI differential lane 2 positive 

4 MIPI_CSI_RX_D3P MIPI-CSI differential lane 3 positive 

5 GND Digital ground 

6 GND Digital ground 

7 MIPI_CSI_RX_D0N MIPI-CSI differential lane 0 negative 

8 MIPI_CSI_RX_D1N MIPI-CSI differential lane 1 negative 

9 MIPI_CSI_RX_D0P MIPI-CSI differential lane 0 positive 

10 MIPI_CSI_RX_D1P MIPI-CSI differential lane 1 positive 

11 MIPI_ CSI_RX 
_CLK0N MIPI-CSI differential clock lane negative 

12 I2C2_SCL I2C serial port 2 clock signal 

13 MIPI_ CSI_RX 
_CLK0P MIPI-CSI differential clock lane positive 

14 I2C2_SDA4 I2C serial port 2 data signal 

15 MCLK Main Clock 

16 CAM_RST Reset control signal 

17 VCC1V8_DVP 1.8V IO power 

18 CAM_PWN Power down control signal 

19 VCC1V5_DVP 1.5V Core power 

20 VCC2V8_DVP 2.8V Analog power 

2.4.9 Audio jack (9) 

VT-SBC-RK66 provides a 3.5mm 4-pole combo audio jack supporting headphone and 
microphone. 
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2.4.10 Speaker connector (10) 

VT-SBC-RK66 provides an L/R speaker (1 × 4 × 2.0mm) that allows connection of a 5W/8Ω 
speaker.  

 

 

 

Pinout description: 

Pin Name Description 

1 OUTR- Class-D H-bridge negative output for right channel 

2 OUTR+ Class-D H-bridge positive output for right channel 

3 OUTL- Class-D H-bridge negative output for left channel 

4 OUTL+ Class-D H-bridge positive output for left channel 

2.4.11 RS232 (11) 

VT-SBC-RK66 provides two RS232 connectors, one is a DB9 male connector (uart4), another 
is a 3-pin connector (uart5). 

 

 

 

 

 

RS232 (DB9) pinout description: 

Pin Name Description 

1 NC  

2 RXDA RS232_RXD 

3 TXDA RS232_TXD 

4 NC  

5 GND Ground 

6 NC  

7 NC  

8 NC  

9 NC  

DB9 RS232 
(uart4) 3-pin RS232 

(uart5) 

1  

1 5 

6 
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3-pin RS232 pinout description: 

Pin Name Description 

1 RXDB RS232_RXD 

2 TXDB RS232_TXD 

3 GND Ground 

2.4.12 RS232/RS485 (12) 

VT-SBC-RK66 also provides two DB9 RS232/RS485 multiplex connectors (uart0 and uart7), 
and users can configure the connectors based on needs. 

 

 

 

 

 

RS232/RS485 pinout description: 

Pin Name Description 

1 RS485_2_A RS485_P 

2 RS485_2_B/RXDF RS485_N/RS232_RXD 

3 TXDF RS232_TXD 

4 NC  

5 GND Ground 

6 NC  

7 NC  

8 NC  

9 NC  

 

 

  

RS232/RS485 
(uart7) 

RS232/RS485 
(uart0) 1 5 

6 
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2.4.13 USB 2.0 (13) 

VT-SBC-RK66 implements four USB 2.0 interfaces (Type-A), including one USB OTG on the 
top right that can switch between host (down) and device (up) modes with the red switch 
next to the USB interfaces. Before switching the OTG modes, please position the switch in 
place before plugging into the USB cable. 

 

 

 

The pinout of these USB 2.0 interfaces is in line with the pin assignment of standard USB 
2.0 (Type-A) interface. 

2.4.14 USB 3.0 connector (14) 

VT-SBC-RK66 provides one USB 3.0 interface (Type-A). 

 

The pinout of the USB 3.0 interface is in line with the pin assignment of standard USB 3.0 
(Type-A) interface. 

2.4.15 GPIO (15) 

VT-SBC-RK66 provides 8 GPIOs (2 × 10 × 2.0mm) to allow connection of peripherals or 
control certain electronic components. 

 

 

 

Please refer to the next page for the pinout description of the connector. 

 

  

USB OTG 

Switch 

2 
1  
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Pinout description: 

Pin Name Description 

1 GND Ground 

2 GND Ground 

3 CPU_GPIO0 CPU general purpose input output 

4 CPU_GPIO4 CPU general purpose input output 

5 GND Ground 

6 GND Ground 

7 CPU_GPIO1 CPU general purpose input output 

8 CPU_GPIO5 CPU general purpose input output 

9 VCC_EXT_3V3 DC 3.3V external power output 

10 VCC_EXT_3V3 DC 3.3V external power output 

11 GND Ground 

12 GND Ground 

13 CPU_GPIO2 CPU general purpose input output 

14 CPU_GPIO6 CPU general purpose input output 

15 GND Ground 

16 GND Ground 

17 CPU_GPIO3 CPU general purpose input output 

18 CPU_GPIO7 CPU general purpose input output 

19 VCC_EXT_3V3 DC 3.3V general purpose input output 

20 VCC_EXT_3V3 DC 3.3V general purpose input output 

2.4.16 Mini PCIe (16) 

VT-SBC-RK66 provides a mini PCIe socket for user expansion to connect a 4G/LTE module. 

 

 

 

 

 

Please refer to the next page for the pinout description of the socket. 

  

51 1  
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The pinout description: 

Pin Name Description 

1 NC  

2 PCIE_3V3 3.3V power supply for 4G module  

3 NC  

4 NC  

5 NC  

6 NC  

7 NC  

8 PCIe_UIM_PWR SIM card power supply  

9 GND Ground 

10 PCIe_UIM_DATA SIM card data interface 

11 NC  

12 PCIe_UIM_CLK SIM card clock 

13 NC  

14 PCIe_UIM_RST SIM card reset 

15 GND Ground 

16 PCIe_UIM_VPP SIM card power supply programming  

17 NC  

18 GND Ground 

19 NC  

20 NC  

21 GND Ground 

22 NC  

23 NC  

24 PCIE_3V3 3.3V power supply for 4G module 

25 NC  

26 GND Ground 

27 GND Ground 

28 NC  

29 GND Ground 

30 NC  

31 NC  

32 NC  

33 NC  
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34 GND Ground 

35 GND Ground 

36 HOST2_DM USB 2.0 signal negative 

37 GND Ground 

38 HOST2_DP USB 2.0 signal positive 

39 PCIE_3V3 3.3V power supply for 4G module 

40 GND Ground 

41 PCIE_3V3 3.3V power supply for 4G module 

42 4G_LED_EN 4G LED ground 

43 GND Ground 

44 NC  

45 GND Ground 

46 NC  

47 GND Ground 

48 NC  

49 GND Ground 

50 NC  

51 GND Ground 

52 PCIE_3V3 3.3V power supply for 4G module 

2.4.17 Reset button (17) 

There is a pinhole reset button on VT-SBC-RK66 for restarting the board upon a short press. 

2.4.18 LED indicators (18) 

VT-SBC-RK66 provides four LED indicators with functions listed below: 

 

 

 

 

Please refer to the following page for the definition of the indicators.  

4G indicator  
Power indicator  

User defined indicator 

System indicator 
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Definition of the indicators: 

Indicator name Definition 

4G indicator Blinking: 4G communication working properly 
Off: Problem with 4G communication 

USER indicator Refer to 3.7 for the command to enable the LED in Android 
system 

POWER indicator Solid red: System power OK 
Off: Problem with system power 

SYS indicator Solid green: System running properly 
Off: System abnormality 

If the power indicator is on while the other three indicators are off, the Board is shut down 
with power connected. 

2.4.19 Micro SD & Micro SIM slots (19) 

VT-SBC-RK66 provides a Micro SD card slot that supports a storage device of up to 128GB.  

The SIM card slot supports SIM card hot plugging. The 4G LTE module of the Board is AT&T 
and Verizon pre-certified, and you may consult your sales executive for the module name 
before applying a SIM card from the carrier. 
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 CHAPTER 3 ANDROID SYSTEM MANUAL 
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This chapter briefs on the settings and common use of the interfaces in the Android system. 
Please connect a mouse, a keyboard and a monitor to VT-SBC-RK66 for smooth operation. 

3.1 Time and Date Setup  

Please confirm if the system time is correct after first bootup. Change of the system settings 
will synchronize the date and time to the RTC which ensures correct display of the system 
time and date after recovery from abrupt power failure or system fault.  

1. Swipe up to unlock the screen; 

2. Navigate to Settings > System > Time and Date in sequence to enter the settings page; 

3. By default, the system applies the date and time zone provided by the network, you 
can keep the settings or change the them manually; 

4. If the system applies the time zone provided by network, please confirm if the time 
zone coincides with your local time zone. If not, please disable the option first; 

5. Then click the Time Zone to access the settings page; 

6. Select a region where the device is located (for instance, United States); 

7. Select a proper time zone for it; 

8. Enable the Time zone provided by network option, which will not change the settings 
you have made; 

9. You can then choose to set the date and time manually or synchronize to the network 
time. If you use the time provided by network, the system time will automatically align 
to the current time zone; 

10. When the time and date are all set, they will be synchronized to the RTC. 

 

To ensure smooth setup, please make sure the Board is connected to Internet if you 
choose the network time.  
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3.2 Enable Developer Options 

To enable Developer options of VT-SBC-RK66, follow the steps below: 

1. Connect VT-SBC-RK66 to a mouse, a keyboard, and a monitor for easier operations; 

2. Click Settings > About <Tablet> in sequence;  

3. Navigate to the bottom and locate Build number, and click it consecutively for at least 
7 times until you see a prompt indicating you are now a developer; 

4. Go back to Settings > System > Advanced > Developer options and toggle on USB 
debugging (under the DEBUGGING sub-menu), then you can customize the device 
settings. 

5. Depending on the Android version, the entry might vary slightly. 

 

3.3 ADB Setup on the Windows host 

Android Debug Bridge (ADB) is a tool that is designed to connect your development 
workstation directly to your Android device for debugging, device upgrading, app 
installation, etc. 

Make sure you have enabled Developer Options and toggled on USB debugging before 
you proceed with the ADB setup as follows. 

1. Unzip the software release package and navigate to the following directory: \SW\tools; 

2. Extract the adb_fastboot_and_other_tools_for_windows zip file; 

3. Navigate to the Android folder that contains the ADB tool kit, and copy the folder path; 
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4. Press “Win + R” and input “sysdm.cpl” in the dialogue box to open the settings 
interface; 

 
 

5. Click in sequence Advanced > Environment Variables > System Variables > Path > Edit, 
and click New in the pop-up; 

 

6. Paste the path of the Android folder, and click OK one by one to confirm and exit; 
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7. Press “Win + R” and input cmd in the dialogue box to open the command prompt; 

8. Input adb version in the command prompt to check if the ADB tool is installed. 
 

 
 
 
 

 
 
 

3.4 App Installation via ADB Commands  

In addition to the standard pre-installed Android applications, users can install their own 
applications on the Board provided that it runs an Android system.  

All tools to be used for the installation are available in the software release package 
provided by Vantron. You can install the apps as long as the Android SDK Platform Tools 
are installed and accessible on the host computer. The Windows environment is used for 
illustration in the following section. 

3.4.1 Prerequisites 

• VT-SBC-RK66 running Android operating system 

• A host computer running Windows 7 or later (with ADB setup finished) 

• A USB cable (Type-A to Type-A) 

• The board is in client mode (OTG switch dialed up) 
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3.4.2 App installation 

1. Connect the Board and the Windows host computer via the USB cable; 

2. Press “Win + R” and input cmd in the dialogue box to open the command prompt; 

3. Input adb devices -l in the command prompt to check if the Board is connected to the 
host computer; 

 

 

4. When the device information is displayed under the command, the Board is an ADB 
device and you can copy the serial number (squared as shown above) for the next step; 

5. Input the following command line to install the app; 

adb -s <serial number> install “<APP path>” 

Make sure there is no special character in the app path. 

6. The installation will be executed after the command line is input and the result of 
installation will be displayed below the command; 

  

 

7. The newly installed app will be displayed on the App drawer in the Alphabetic order. 

 

The screenshots are for illustration only and are not intended to represent the actual 
device number and other information of the device currently in your possession. 

In step 4 shown above, you can drag the .apk file from the local directory to the 
command line to replace the <App path> you typed in manually. 
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3.5 Image Flashing on a Windows Host 

Whenever a new image is available, Vantron will provide a release package consisting of 
all the tools/files necessary so that you can flash the image as needed. This section briefs 
on the image flashing on a Windows host. 

3.5.1 Prerequisites  

• VT-SBC-RK66 

• A host computer running Windows 7 or later (with ADB setup finished) 

• A USB cable (Type-A to Type-A) 

• The board is in client mode (OTG switch dialed up) 

3.5.2 Driver installation  

1. Unzip the release package, and open the directory of the upgrade driver (\SW\ 
DriverAssitant_vxxx) to locate the DriverInstall.exe; 

 

2. Right click the mouse and run the program as administrator; 

3. Click Uninstall Driver first to remove the previously installed driver, if any, then click 
Install Driver and wait; 
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4. A pop-up will appear in a second suggesting the driver is installed; 

 

 
5. Open the directory of the upgrade tool (path: \SW\AndroidTool\RKDevTool_Release_ 

vxxx\RKDevTool); 

 
6. Double click RKDevTool.exe to open the upgrade window; 
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7. Connect VT-SBC-RK66 to the Windows host with the USB Type-A to Type-A cable; 

8. Press “Win + R” and input cmd in the dialog box to open the command prompt;  

9. Input adb devices in the command prompt to check if the Board is connected to the 
Windows host; 

10. Once the Board is identified by the Windows host, input adb shell in the command 
prompt for executing shell commands to the Board; 

 
11. Input reboot loader to reboot the Board and it will enter the Loader mode; 

 
 
 

12. Then the upgrade window will prompt for the existence of a Loader device, indicating 
that the upgrade process is ready. 
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3.5.3 Image Flashing 

1. Click the Upgrade Firmware tab in the RK Device Tool window (the second tab on the 
top of the window) and then click the Firmware button; 

2. Open the image file update.img from the local directory (\SW\Image), and the 
firmware details will be automatically populated; 

3. Click the Upgrade button (next to the Firmware button), and the Board will start to 
download the image and upgrade; 

 

 

4. When the upgrade finishes, the Board will reboot automatically.  
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3.6 Serial Ports 

VT-SBC-RK66 offers two RS232 connectors (uart4 and uart5) and two RS232/RS485 
connectors (uart0 and uart7) for serial communication. 

To test if the serial ports function properly: 

1. Connect the Board to a Linux host (Ubuntu 22.04 for instance) with the USB cable (Type-
A to Type-A); 

2. Use a proper serial adapter to connect the target serial port to a serial device; 

Refer to 2.4.11 and 2.4.12 for the pinout description of the ports. 

3. Open a terminal and install a serial communication program (‘microcom’ for instance); 

$ sudo apt install microcom 

4. Input the following command line to install ADB tool; 

$ sudo apt install adb 

5. Check if the Board is connected to the Linux host via ADB; 

$ adb devices -l 

 
 
 
 

6. Input adb shell in the terminal to execute shell commands on the Board; 

 
 
 
 
 
 
 
 
 
 
 

7. Input su in the terminal to switch to the root user; 
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8. Enter cd sys/van-misc to access the directory of the serial ports as follows: 

 

 

9. Set the baud rate (9600 for instance) of the serial ports (uart4 for instance); 

# microcom -s 9600 /dev/ttyS4 

<Text the data to send to the connected device> 

10. For the RS232/RS485 ports, input the following commands to switch the mode of the 
port: 

# echo 1 > sys/van-misc/uart0_mode      // uart0 RS232 mode 

# echo 0 > sys/van-misc/uart0_mode      // uart0 RS485 mode 

# echo 1 > sys/van-misc/uart7_mode      // uart7 RS232 mode 

# echo 0 > sys/van-misc/uart7_mode      // uart7 RS485 mode  

 

3.7 GPIO 

VT-SBC-RK66 provides 8 GPIOs, starting from GPIO0 to GPIO7. GPIO0 to GPIO7 correspond 
to GPIO104, GPIO107, GPIO108, GPIO109, GPIO110, GPIO111, GPIO112, and GPIO113 in 
the software system, respectively. 

Please refer to 2.4.15 for the pinout description of the GPIOs. 

Before you start to use the GPIOs, please install the ADB tool on the Linux host, if necessary, 
as set out in step 4 in 3.5。 

1. Execute adb shell command in the terminal; 

2. Input the following commands to enter the directory of the GPIO and check GPIO nodes: 

~# cd sys/class/gpio/ 

 /sys/class/gpio # ls 
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3. Set a GPIO (GPIO104 for instance) to the high level; 

# echo 1 > /sys/class/gpio/gpio104/value 

# cat /sys/class/gpio/gpio104/value 

4. Set a GPIO (GPIO104 for instance) to the low level; 

# echo 0 > /sys/class/gpio/gpio104/value 

# cat /sys/class/gpio/gpio104/value 

Follow the same way to set the levels of the remaining GPIOs. 

 

3.8 User Indicator Control 

There is a user-defined LED indicator on VT-SBC-RK66 (refer to 2.4.18 for details), users can 
use the following command line to enable and disable the indicator. 

1. Install ADB tool in the Linux system, if needed, as set out in step 4 in 3.5; 

2. Execute adb shell command in the terminal; 

3. Input the following commands to enable and disable the indicator. 

# echo 1 > /sys/van-misc/user_led         [enable] 

# echo 0 > /sys/van-misc/user_led         [disable]  
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 CHAPTER 4 DEBIAN SYSTEM MANUAL 
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This chapter briefs on the settings and common use of the Interfaces in the Debian system. 
Please connect a mouse, a keyboard and a monitor to VT-SBC-RK66 for smooth operation. 

4.1 About the System 

Debian is a Linux distribution and the Device was built by Debian GNU/Linux 10 operating 
system.  

4.1.1 User and password 

The system will automatically log in without the need to input the password. However，
if you have switched the account/locked the screen/logged out, you will be prompted to 
input the password to log in the system. 

° Default user: vantron 

° Password: vantron 

4.1.2 System information 

1. Connect a mouse, a keyboard and a monitor to VT-SBC-RK66; 

2. Power on the Device to login; 

3. Click the Debian icon, then click System Tools > LXTerminal in sequence to open the 
system terminal; 

4. Input cat /etc/os-release in the terminal to check the system information; 

 
5. Input sudo su to switch to the root user (no password). 
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4.2 System Settings  

By clicking on the power icon         on the bottom right corner of the screen, you can 

° Shut down/Restart/Suspend the Device 

° Lock the screen  

° Switch the user  

° Log out the current user 

 

The menu bar on the bottom of the screen: 

° Main menu: You can open accessories, applications, the console terminal, or 
customize the system settings 

° File manager: Provides access to device files, applications 

° Web browser: Provides access to webs on Internet 

° Window tool: To minimize or fold the windows 

° Desktop switch: To switch between working areas 

° CPU usage: Displays the CPU usage in real time 

° Volume menu: Adjusts the system volume 

° Virtual keyboard: To open/close the virtual keyboard, set the input method upon 
a right click of the mouse 

° Network settings: You can connect to Ethernet/Wi-Fi/VPN, or create/edit the 
connection 

° Bluetooth settings: To pair and set up the Bluetooth devices 

° System time 

° Screen lock 

° Power icon 
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4.2.1 Language setup 

Assume the system langue is Simplified Chinese. The following example demonstrates 
how to change the system langue to English (US). 

1. Right click the mouse on the desktop background; 

2. Select the desktop preference option at the bottom of the menu; 

 

3. Check the ‘show menus provided by window managers when desktop is clicked’ 
option (first line) in the advanced menu (third tab) to change the right-click menu; 

 
4. Return to the desktop background and open the terminal emulator; 

5. Input sudo su in the terminal to switch to the root mode; 

 

6. Run the following command to check the language currently used by the system; 

# env | grep LANG 
LANG= zh_CN.UTF-8            // the system language is simplified Chinese 
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7. Run the following command to call the locale configuration page (en_US.UTF-8 refers 
to the locale for the target language that you wish to switch to); 

# export LANG=en_US.UTF-8 

8. Use the following command to re-configure the locales; 

# dpkg-reconfigure locales 

9. Use the up and down arrows on the keyboard to move to the target locale 
(en_US.UTF-8); 

10. Press “Space” in front of the target locale to select the language; 

a  
11. Move down to the current locale (zh_CN.UTF-8) and press “Space” to uncheck the 

current language; 
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12. Press “Tab” to move the cursor to the <OK> option and press “Enter” to confirm your 
choice; 

13. In the following pop-up, use the up and down arrows to move to the target locale 
(en_US.UTF-8) in the list, then press “Tab” to move the cursor to the <OK> option and 
press “Enter” to confirm your choice; 

14. Wait a few seconds for the locale to take effect; 

 

15. Then input reboot to restart the system; 

16. Select “Update Names” after device reboot to update the files to the current 
language; 

17. Run locale -a command to check if the locale is set as the default system language. 

4.2.2 Time and date setup 

Please confirm if the system time is correct after first bootup. To change the system time: 

1. Click the Debian icon > Preference > Time and Date to open the Time and Date 
settings; 
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2. Click Unlock and enter the password (vantron) before editing; 

3. Click Time zone and select the correct one for the Device from the list; 

4. Choose to synchronize the time with the Internet server (device shall have Internet 
access) or fill in the time manually; 

5. Click Lock and close the window; 

6. Reboot the device to let the settings take effect. 

 

The real-time clock (RTC) component provides accurate time and date information for the 
system after its recovery from abrupt power failure r system fault. When necessary, follow 
the steps below to synchronize the RTC and system time. 

1. Click the Debian icon > System Tools > LXTerminal to open a terminal; 

2. Input sudo su to switch to the root user; 

3. Set the date and time for the system； 

# date -s "2023-03-24 14:38:10" 

4. Synchronize the date and time to the RTC; 

# hwclock -w 

5. Reboot the Device; 

# reboot 

6. Check the RTC information. 

# hwclock -r 
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4.2.3 Network configuration 

The Device is configured to have Internet access once it connects to a live Ethernet or joins 
to a Wi-Fi network.  

Make sure you have installed the Wi-Fi antennas before connecting to an existing wireless 
network. 

1. To join to a Wi-Fi network, click the network icon     on the menu bar and search for the 
target network in the list; 

2. Input the password of the target Wi-Fi network and wait for the connection; 

3. To check the current network connection, you can move the cursor to the network icon, 
and right click the mouse to select Connection Information: 

 

4. To edit the network configurations, you can right click the network icon and select Edit 
Connections, then select a connection and click the cog icon to edit the settings. 
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4.3 Image Flashing on a Windows Host 

Whenever a new image is available, Vantron will provide a release package consisting of 
all the tools/files necessary so that you can flash the image as needed. This section briefs 
on the image flashing on a Windows host. 

4.3.1 Prerequisites 

• VT-SBC-RK66 

• A host computer running Windows 7 or later (with ADB setup finished) 

• A USB cable (Type-A to Type-A) 

• The device is in client mode (OTG switch dialed up) 

4.3.2 Driver Installation 

1. Unzip the software release package and open the directory of the upgrade driver 
(\DriverAssitant_vxxx) to locate the DriverInstall.exe; 

 

2. Right click the mouse and run the program as administrator; 

3. Click Uninstall Driver first to remove the previously installed driver, if any, then click 
Install Driver and wait; 
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4. A pop-up will appear in a second suggesting the driver is installed; 

 

5. Return to the release package and open the directory of the upgrade tool (path: 
\RKDevTool_Release\ RKDevTool.exe); 

 

  

http://www.vantrontech.com/


Vantron | Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 VT-SBC-RK66 | User Manual                                            47 www.vantrontech.com 
 

6. Double click RKDevTool.exe to open the upgrade window; 

 

7. Connect VT-SBC-RK66 to the Windows host with the USB Type-A to Type-A cable; 

8. Press “Win + R” and input cmd in the dialog box to open the command prompt;  

9. Input adb devices in the command prompt to check if the Device is connected to the 
Windows host; 

10. Once the Device is identified by the Windows host, input adb shell in the command 
prompt for executing shell commands to the Device; 

 
11. Input reboot loader to reboot the Device and it will enter the Loader mode; 
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12. Then the upgrade window will prompt for the existence of a Loader device, indicating 
that the upgrade process is ready. 

 

 

4.3.3 Image flashing 

1. Click the Upgrade Firmware tab in the RK Device Tool window (the second tab on the 
top of the window) and then click the Firmware button; 

2. Open the image file update.img from the local directory (\rockdev), and the firmware 
details will be automatically populated; 

3. Click the Upgrade button (next to the Firmware button), and the Device will start to 
download the image and upgrade; 

 

4. When the upgrade finishes, the Device will reboot automatically.  
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4.4 Serial Ports 

VT-SBC-RK66 offers two RS232 connectors (uart4 and uart5) and two RS232/RS485 
connectors (uart0 and uart7) for serial communication. The ports are mapped as 
/dev/ttyS0, /dev/ttyS4, /dev/ttyS5, and /dev/ttyS7 respectively in the system. 

The RS232/RS485 multiplexers will switch the mode automatically based on the wiring 
by the user. Please refer to 2.4.11 and 2.4.12 for the pinout description of the connectors. 

To test if the serial ports function properly: 

1. Connect the Device to a Linux host (Ubuntu 22.04 for instance) with the USB cable 
(Type-A to Type-A); 

2. Use a proper serial adapter to connect the target serial port to the host computer; 

3. Set the baud rate (115200 for instance) of a serial port (uart0 for instance); 

$ adb shell      // open the device shell (not necessary if you use the console) 

# su           // enable the root privilege (not necessary if you use the console) 

# stty -F /dev/ttyS0 speed 115200    // set the baud rate of uart0 to 115200 

4. Test for serial communication. 

# cat /dev/ttyS0 &                      // receive data 

# echo TEST > /dev/ttyS0                // send data 

 

 

  

http://www.vantrontech.com/


Vantron | Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 VT-SBC-RK66 | User Manual                                            50 www.vantrontech.com 
 

4.5 4G module 

VT-SBC-RK66 integrates an automatic dial-up script. The dial-up fails when there is no SIM 
card in the slot, yest the normal operation of the Device will not be impacted. 

Before using the cellular communication, please remember to insert the activated SIM 
card into the SIM slot and install the 4G antennas before power up. 

1. The dial-up script runs automatically upon power up; 

2. Use the ifconfig command to check the information of the network card (PPP0 in this 
case) after successful dial-up; 

 

3. Test the network connection using the ping command. 
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4.6 Ethernet 

VT-SBC-RK66 is configured to connect to Internet once it connects to a live Ethernet. 

1. Connect the RJ45 Ethernet jack of the Device to network; 

2. Use the ifconfig command to check the information of the network card (eth0 in this 
case); 

 
3. Test the network connection using the ping command. 

 

 

4.7 USB 

When any of the USB interfaces connects to a storage device, input the following 
commands to check/configure the USB interface. 

1. Check the USB interface information: 

$ lsusb 
2. Mount the USB device to a specified directory (e.g., /mnt): 

$ mount /dev/xxx /mnt 
3. Check the mounted content in /mnt: 

$ ls /mnt 
4. Unmount the USB device from /mnt: 

$ umount /dev/mnt 
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CHAPTER 5 DISPOSAL AND WARRANTY 
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5.1 Disposal 

When the device comes to end of life, you are suggested to properly dispose of the 
device for the sake of the environment and safety. 

Before you dispose of the device, please back up your data and erase it from the device. 

It is recommended that the device is disassembled prior to disposal in conformity with 
local regulations. Please ensure that the abandoned batteries are disposed of according 
to local regulations on waste disposal. Do not throw batteries into fire or put in common 
waste canister as they are explosive. Products or product packages labeled with the sign 
of “explosive” should not be disposed of like household waste but delivered to 
specialized electrical & electronic waste recycling/disposal center.  

Proper disposal of this sort of waste helps avoid harm and adverse effect upon 
surroundings and people’s health. Please contact local organizations or 
recycling/disposal center for more recycling/disposal methods of related products. 

 

 

 
 
 

http://www.vantrontech.com/


Vantron | Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 
 

 VT-SBC-RK66 | User Manual                                            54 www.vantrontech.com 
 

5.2 Warranty  

Product warranty 

VANTRON warrants to its CUSTOMER that the Product manufactured by VANTRON, or 
its subcontractors will conform strictly to the mutually agreed specifications and be free 
from defects in workmanship and materials (except that which is furnished by the 
CUSTOMER) upon shipment from VANTRON. VANTRON’s obligation under this warranty 
is limited to replacing or repairing at its option of the Product which shall, within 24 
months depending on the Product after shipment, effective from invoice date, be 
returned to VANTRON’s factory with transportation fee paid by the CUSTOMER and 
which shall, after examination, be disclosed to VANTRON’s reasonable satisfaction to be 
thus defective. VANTRON shall bear the transportation fee for the shipment of the 
Product to the CUSTOMER. 

Out-of-Warranty Repair 

VANTRON will furnish the repair services for the Product which are out-of-warranty at 
VANTRON’s then-prevailing rates for such services. At customer’s request, VANTRON will 
provide components to the CUSTOMER for non-warranty repair. VANTRON will provide 
this service as long as the components are available in the market; and the CUSTOMER 
is requested to place a purchase order up front. Parts repaired will have an extended 
warranty of 3 months. 

Returned Products 

Any Product found to be defective and covered under warranty pursuant to Clause above, 
shall be returned to VANTRON only upon the CUSTOMER’s receipt of and with reference 
to a VANTRON supplied Returned Materials Authorization (RMA) number. VANTRON 
shall supply an RMA, when required within three (3) working days of request by the 
CUSTOMER. VANTRON shall submit a new invoice to the CUSTOMER upon shipping of 
the returned products to the CUSTOMER. Prior to the return of any products by the 
CUSTOMER due to rejection or warranty defect, the CUSTOMER shall afford VANTRON 
the opportunity to inspect such products at the CUSTOMER’s location and no Product so 
inspected shall be returned to VANTRON unless the cause for the rejection or defect is 
determined to be the responsibility of VANTRON. VANTRON shall in turn provide the 
CUSTOMER turnaround shipment on defective Product within fourteen (14) working 
days upon its receipt at VANTRON. If such turnaround cannot be provided by VANTRON 
due to causes beyond the control of VANTRON, VANTRON shall document such instances 
and notify the CUSTOMER immediately. 
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